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1 INTRODUCTION 

DMX (Digital Multiplex) is a handling protocol used for event technology, so it is robust, fail-safe and 
built up simply. The standard as of today exists since 1990 and due to its wide spread distribution it 
offers a lot of functionalities by low asset costs. 
 
The DUODMX GATEWAY has two independently configurable DMX outputs, each with 512 channels.  
This enables two rooms to be controlled independently of one another. The device can be operated as a 
DMX master or slave. The gateway transmits DMX packages in master mode and receives them in slave 
mode. Five different versions enable the device to be used in almost any scenario of requirements.  The 
device acts as a DMX gateway for KNX® or EnOcean® systems, but can also be operated on a 
standalone basis – in other words, directly addressed, e.g. via the browser of your smart phone. The 
professional configuration software not only enables the dimming of individual channels, but also the 
programming of complex sequences.  The DUODMX GATEWAY is ideally suited for concealed 
retrofitting in ceilings. A corresponding adapter is available for top hat rail installation.  
 
 

2 THE GATEWAY 

The DUODMX GATEWAY is laid out for ceiling installation. Due to its compact measures it can be used 
for complicated mounting lays too. The device has two separate DMX interfaces and controls these 
independently of one another 
 
Specifications: 
 
Power Supply:  

 Power over Ethernet (PoE) or  (RJ-45) 
 connection clamp:   12-30V DC 
 Power consumption:   <= 1,2VA 

 
Mechanic Data: 

 Mounting:    Ceiling installation / DIN Rail Bar adapter: 
DIN Rail Bar EN 50022 – 35x7,5 

 Measures (W x H x D) in mm:   without grounding clip: 50x26x116 
With grounding clip: 50x26x146 

Interface (depending of model type): 
 KNX      via connection clamp (Twisted Pair) 
 Ethernet     via RJ45-jack 
 EnOcean     via external SMA antenna 
 2xDMX 512     Connection clamp nominal wire size: 1,5mm² 
 Pushbutton input    Connection clamp nominal wire size: 1,5mm² 
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3 MOUNTING 

The device can be used for installation in ceilings or alternatively for DIN Rail mounting. In case of 
ceiling mounting the device has grounding clips on each side. For DIN Rail mounting an additional 
adapter has to be used. The grounding clips can be broken off easily if wanted. 
 

 
Figure 1: DUO DMX GATEWAY with grounding clips 

 
DIN Rail Bar adapter 
The adapter is fixed on the chassis with 2 screws (part of delivery). Please note that the adapter only 
may be screwed in the two folded holes.  
 

 
Figure 2: DIN Rail Bar Adapter 

 
Note: Please attach the DIN rail Adapter only on the two marked holes. Using the wrong holes the 
screw ends might touch the bottom of the circuit board! 
 
Please be careful if you need to troubleshoot a device mounted on the DIN rail. Pull with too much 
force on the gateway, the screws can be pulled out from the chassis. 
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3.1 CONNECTION PLAN 

In the following image you will find an overview over the connection the DUODMX GATEWAY offers in 
all available variants. 
 
 

 
Figure 3: DUO DMX GATEWAY - connection overview 

 
Device model: Extension (article No. 12000) 
As an extension the unit is controlled via the "BMX" protocol of eibPort. 
Communication takes place over the network. Therefore the device has to be connected to the local 
network. 
 
Device model: KNXnet / IP (article No. 12010) 
As KNXnet / IP version the device's control commands are received via the "KNXnet / IP" protocol. 
Therefore, the device must be connected to the network, too. 
 
Device model: KNX / TP (article No. 12020) 
As KNX Twisted Pair version, the device is directly connected to the twisted pair wiring of the KNX bus. 
For this purpose the device has two terminals on one of the connectors. 
 
Device model: EnOcean (article No. 12030) 
The EnOcean device can manage by the control signals of EnOcean radio. The device only requires a 
power supply. Moreover, the external antenna of the device can be connected. The link to the EnOcean 
profiles is done with the software DMX Configurator. 
 
Device model: Standalone (Article No. 12040) 
As a standalone variant, the Gateway receives the DMX commands via a smart phone app. The device is 
integrated into the existing WLAN via the WLAN antenna.  
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Device model: Extension SR (Article No.: 12100) 
The “Extension SR” version not only permits the transmission of DMX commands on the basis of 
incoming BMX commands (see “Extension version” above), but also sends BMX telegrams on the basis of 
incoming DMX commands. The master/slave configuration (transmit/receive) of the DMX interfaces can 
be performed separately for each interface. The connection is performed in the same way as for the 
device versions without “SR”. In order to be able to transmit and receive simultaneously on one DMX 
cable, a jumper can be inserted from one interface to the other. The DMX interfaces are short-circuit 
proof.  
 
Device model: KNXnet/IP SR (Article No.: 12110) 
The “KNXnet/IP SR” version not only permits the transmission of DMX commands on the basis of 
incoming KNXnet/IP SR telegrams (see “KNXnet/IP SR version” above), but also transmits KNXnet/IP SR 
telegrams on the basis of incoming DMX commands. The master/slave configuration (transmit/receive) 
of the DMX interfaces can be performed separately for each interface. In order to be able to transmit 
and receive simultaneously on one DMX cable, a jumper can be inserted from one interface to the 
other. The DMX interfaces are short-circuit proof. 
 
Device model: KNX/TP SR (Article No.: 12120) 
The “KNX/TP SR” version not only permits the transmission of DMX commands on the basis of incoming 
KNX/TP telegrams (see “KNX/TP version” above), but also transmits KNX/TP telegrams on the basis of 
incoming DMX commands. The master/slave configuration (transmit/receive) of the DMX interfaces can 
be performed separately for each interface. In order to be able to transmit and receive simultaneously 
on one DMX cable, a jumper can be inserted from one interface to the other. The DMX interfaces are 
short-circuit proof. 
 
Connection with the DMX bus  
The device has two independently from each other acting DMX outputs. Depending on the device type, 
the interfaces can be used as required either as a DMX master (sending) or DMX slave (receiving). The 
connection is realized via a 6 pin Screw terminal, the polarity is marked on the case. Of course it can 
also be used with only one output connector. The interfaces are short-circuit proof (in the case of device 
types “SR”) and can be bridged.  
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4 PUT IT INTO OPERATION 

When ceiling mounted, the gateway can be installed near the DMX system. For operation you need the 
following components: 
 

 Power supply (or PoE) 
 connection to the network (not mandatory, but would be an advantage) 
 connection to the DMX bus 
 connection to one of the controlling medias (network, KNX or EnOcean) 
 the software "DMX Configurator" 

 
The configuration for the device is done using the software "DMX Configurator" over the network or a 
SD-card. Which device is concerned is irrelevant 
 
Please note: The initial configuration must be performed with an SD card. 
 
For this purpose you will requires a standard SD card and a card-reader device for your PC. 
 
 

4.1 DMX-CONFIGURATOR INSTALLATION 

Please first install the software “DMX-Configurator”. The setup file for installing the software "DMX 
Configurator" can be found on the CD or can be downloaded at www.bab-tec.de. The Software is MS-
Windows® based. 
 
Installation Instructions: 
Please double-click the file "setup.exe". The Setup dialog opens: 
 

 
Figure 4: DMX-Configurator - Setup Dialogue 

 
By clicking on "Next" you can move through the menu. Accept the license agreement and select an 
installation location on your hard disk. Select "Finish" at the end and the installation wizard has installed 
the program on your PC. 
 
After installation you find the program under "Start"> "Programs"> "DMX Configurator". 
 

  

http://www.bab-tec.de/
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4.2 DMX-CONFIGURATOR  UPDATE 

Do you want to install a newer version of the DMX Configurator, it is important to uninstall the old 
version first properly. To do this go to "Start"> "Control Panel"> "Programs and Features" (in Windows 
XP "software") and then remove the "DMX Configurator". Now select the new setup file and proceed as 
described above. 
 
 

4.3 DEFAULT SETTINGS 

The DUODMX GATEWAY is delivered with the following factory settings: 
 

 IP-address: 192.168.1.223 
 Subnetzmaske: 255.255.255.0 
 Device name: MAC Adresse des Gerätes 
 Physical address KNX: 15.15.255 
 Mulitcast address KNXnet/IP (“Routing”): 224.0.23.12 (cannot be changed) 
 EIBPort System ID: 0 (cannot be changed, important only for type 12000) 

 
 

4.4 INITIAL COMMISSIONING 

Connect the standard 12-30V power supply (DC) to the connection clamps or connect the device to 
PoE enabled network cable. The power LED is lighting constant green if the device is in operation. 
 
Note: You require an SD card for the initial commissioning 
 

 Start the DMX-Configurator and browse to the menu “Extensions” – “DUODMX GATEWAY”. 
 

  
Figure 5: DMX-Configurator – extensions 

 
 You will be asked to choose the device type you are using You have the following choices: 

• „KNX/BMX“: for following device variants:  
o „Extension“(Art.-Nr. 12000),  
o „KNXnet/IP“ (Art.-Nr. 12010)“ oder  
o „KNX/TP“ (Art.-Nr. 12020). 

 
• „KNX/BMX Master/Slave“: for following device variants 

o „Extension SR“ (Art.-Nr. 12100) 
o „KNXnet/IP SR“ (Art.-Nr. 12110) 
o „KNX/TP SR“ (Art.-Nr. 12120) 

 
• „EnOcean“ for following device variants 

o „EnOcean“ (Art.-Nr. 12030). 
 

• „WLAN“ for following device variants 
o „Standalone“ (Art.-Nr. 12040) 
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Figure 6: DMX-Configurator - device Selection 

 
Depending on your selection, four different configuration windows are made available. For a detailed 
description, please read the section on “Expansions”.  
 
Note: For the initial commissioning it is of primary importance that you introduce the DUO DMX 
GATEWAY with the aid of an SD card into the same network area as your PC. In the sequence 
below, you can transfer all other configuration data easily via the network.  
  

 Retrieve the network settings of the device as follows:  
• When selecting “KNX/BMX“ and “KNX/BMX Master/Slave“ click on the “LAN/KNX“ tab. 
• When selecting “EnOcean“, click on the “LAN/EnOcean“ tab. 
• When selecting “WLAN“, click on the “WLAN“ tab. 

 
The diagram below shows a sample configuration for “KNX/BMX“. 

 
Figure 7: DMX-Configurator - Window LAN/KNX 

 
 Below the “DMX Gateways“ field, click on the “Search“ button. This displays all DUODMX 

GATEWAYs to be found in the network, regardless of the IP addresses of the local PCs.  
 
 on the basis of the search result (the displayed IP address) whether 

adaption of the IP address of the DUODMX GATEWAY is necessary or 
 

 If an adaptation is necessary, make the necessary settings in the 
fields provided for this purpose (“IP address“, “Subnetwork“, 
“Gateway“).  
 

 Then close the “Expansion” window again and save the project 
using the “File” – “Save as” menu option (so that you can expand it 
at a later stage). 
 
 

 
 

Figure 8: Adapt network settings 
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 Open the “File“ menu again and save the project using “Export HEX File“ with a unique name in 
the required folder.  

 
 Insert the SD card in your card reader, ensuring that the SD card contains 

no data.  
 

 Then copy the generated HEX file to the SD card and rename it to 
“config.par“.  

 
 Insert the SD card in the slot of the DUODMX GATEWAY. The green 

operating LED of the device goes out briefly while the data is being read 
in. The configuration is loaded as soon as the green operating LED lights up 
again.  

 
 Restart the device by using the power supply switch.  

 
 Open the DMX Configurator and check, as described in the steps above, whether the DUODMX 

GATEWAY has accepted the new IP address settings. From now on, you can easily transfer all 
configuration changes via the network (see Section on “Transferring configuration data“).  

 
 
  
 
 

  

Figure 9: save project 
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4.5 IMPORTANT VERSION INFORMATION 

Find Software version  
The version number of the DMX-Configurator can be read in the title bar of the window. 
 

  
Figure 10: DMX-Configurator Version 

 
New software and firmware 
Since the DMX Configurator Version 1.6.0.0 the software only will work with devices that will have at 
least firmware 2.0.0.1. To check which firmware you have in use in your device, please use the "Search" 
function in the tab "Lan / KNX" , LAN EnOcean or rather “WLAN” in menu "Extension". Compare also 
the chapter "Activating the DMX Preview". The firmware version is displayed along with the IP address 
and device name. 
 

  
Figure 11: Displaying firmware version 

 
If your device does not have the required firmware version a firmware update is required (see "Firmware 
Update"). If a device received once the firmware 2.0.0.1 or later, it may have to copy the configuration 
data only from the DMX Configurator 1.6.0.0 or later. If you have an older version of the DMX 
Configurator, please download the actual one from our homepage. 
 
Older project data 
Projects from older versions of DMX-Configurator can be opened without problems in the latest 
software version (DMX-Configurator). Once a device is already loaded with a configuration before a 
firmware update is done, it has (after the firmware update is done) to be reloaded with the software 
(1.6.0.0 or later) into the device. 
 
 

4.6 BEHAVIOUR IN CASE OF POWER FAILURE 

Behavior in case of power failure 
The behavior of DMX devices in a power failure at the DUODMX Gateway depends on the devices its 
one. According to DMX specification a subscriber moves to a safe operating condition (eg, lamp off). By 
return of the power supply, all DMX channels set to the value "0". 
 
Behaviour on bus voltage failure (only KNX / TP device) 
In the event that the bus voltage fails but the power supply of the device remains upright, only the 
control of the DUODMX GATEWAY is interrupted. The DMX signal is still sent, so the current "picture" of 
the DMX outputs remains. Even after the return of the bus voltage nothing varies in the DMX range 
(unless new KNX telegrams are send). 
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5 PROGRAMMING 

The programming of the DUODMX Gateway is done over the DMX-Configurator. There the scenes are 
set up, the Group Addresses resp. EnOcean Profiles are linked to the dim outputs or the scenes. The 
configuration is transferred over the network or over an SD-card into the device.  
 
 

5.1 ENABLING THE (DMX-) PREVIEW 

In conjunction with the DUODMX GATEWAY the "DMX Configurator" software provides a so called 
"DMX Preview. In the Preview all changes made to the DMX channel controllers are made directly visible 
on the terminal device. In this way, the sequences and scenes can be directly tested and modified if 
necessary, without having to transfer the configuration first.   
 
Note: Please note that the DMX Preview transmits permanent values for as long as the DMX Configurator 
is opened and the Preview is activated. If you were then to try and control the DMX channels by means 
of the respective bus system, its commands would be overwritten by those of the active preview. Make 
sure that you only use either the preview or the corresponding control system (KNX, BMX, EnOcean ). 
 
The preview can be done in two ways 
 

1. Broadcast Preview: All DUODMX GATEWAY in the network are addressed using the preview no 
matter what network settings you have and whether they just allow the PC from the DMX-
Configurator to be started. The preview will be sent via Broadcast signals into the network. 
 

2. Unicast Preview: Only a selected DUODMX GATEWAY receives the preview signals. It is 
important to note, that the desired gateway and the PC are within the same network area. The 
signals are sent via Unicast to a specific IP address. 
 

Which of the two DMX outputs are used for the Preview signals can be choose. To activate the preview, 
go to the menu "Extensions"> "DUO-DMX Gateway". 
 
Activation of the broadcast Preview 
To activate the broadcast preview just one of the two (or both) checkboxes "DMX Out 1" or "DMX Out 
2” has to be selected. Choose your selection and confirm with “OK”. From now on, the preview will be 
sent via broadcast signals into the network and interpreted by all available gateways. 
 
 

  
Figure 12: Broadcast Preview 
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Note: The preview is no setting that is transmitted to the gateway or will be stored in the project 
data of the DMX-Configurator. This setting is only to be activated on the client. 
 
Activation of unicast Preview 
To preview specifically addressed to a particular device, it is necessary that the appropriate device 
appears in the list "DMX Gateway." To achieve this, click the button "Search". Thus, all are located in 
the network devices with IP address and device name (default setting the MAC address). In order to 
activate the preview for one of the devices in the list, the corresponding device must be marked (blue 
background) and the preview then activated by clicking the checkbox. 
 

  
Figure 13: Unicast Preview 

 
Note: Please note that the PC and the DUO DMX GATEWAY must reside in this case in the same 
area network (subnet)! 
 
To set the DUODMX GATEWAY to the desired IP address range, please have a look at the section 
"Extensions". 
 
Firewall settings 
If a firewall is installed on the client computer it must be unlocked for the DMX-Configurator for ports 
4042, 4044 and 4045. 
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5.2 DMX CONFIGURATOR 

The DMX control software “DMX Configurator” is used to create light images (Step) and light scenes 
(Scene). The configuration data following out of that will be transferred over the network or by SD-card 
to the device. Apart from that, a preview function shows changing’s on the DMX-controllers of the DMX-
Configurator directly on the DMX end devices. The software is suitable for all current versions of 
Windows and can be found on the supplied CD or downloaded from www.bab-tec.de (“Service” – 
“Downloads”).  
 

5.2.1 USER INTERFACE 

The user interface is clearly structured into five broad areas. 
 

1. Administration of the scenes 
2. Scene settings 
3. Administration of steps  
4. DMX channel settings  
5. Menu bar settings 

 

  
Figure 14: DMX Configurator – User interface 

 
 
 
Using the menu bar to configure various features of the software and hardware can be reached. These 
are described separately below. 

  

1 4 

5 2 3 

http://www.bab-tec.de/
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5.2.2 CHANGE MENU LANGUAGE 

In order to change the menu language of the DMX-Configurator, open the menu under the "?" 
(Question mark). The DMX-Configurator must be restarted for it! 
 
 

5.2.3 GENERAL DESIGN OF THE DATA STRUCTURE 

The input of the sequence is done in two steps. First a scene is created, forming a so-called envelope for 
each step (Steps) of the light flow. 
 

 
 
A scene can contain one or more steps, where at a static light image is generated by only one step or a 
dynamic light image with multiple steps. 
 
 

5.2.4 GENERATING SCENES 

Before the entry of individual steps can be made a scene must be selected or 
created. 
 
 

Creating a new scene takes place with the button  . 
 
A new entry scene is inserted into the scene list. This name can be edited freely.  
 

The Button  copies all selected scenes including all their steps. 
 

 deletes the selected scenes including all their steps. 
 

The arrow box  serves for displacing the scenes within the scene’s list. 
 
Important Note: 
At the start of each scene the DMX-Configurator is assumed that the 
corresponding DMX channel holds the value "0". If not so, it may happen 
that a new scene added up its DMX values to existing values (of the old scene). The lamp will 
display incorrect values. 
 
That behavior does not occur if each scene is first started with a step, with the value "1" and a 
subsequent step with the value "0". Between the two steps is not a "fade" and a minimum "wait 
time" of 50 ms. In this way, each DMX channel is set to the value of "0" before starting the actual 
scene. Maybe it is reasonable to create a special scene, which only serves to set "0" to the 
desired DMX channels.   

PROJEKT
SZENE 1

SCENE 2

STEP 1
STEP 2
STEP 3

STEP 1

Figure 15: Scene’s list 
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5.2.5 CREATING OF STEPS 

By creating and editing steps, the individual light image is created and when linked together, a dynamic 
light image will follow. Static light images are to create with only one step. 
 
 
 
 

 
Figure 16: Steps erstellen 

 
 
 
For the setting of different DMX values 12-channel slide controls are available. These are labeled with 
the channel number. To reach all 512 channels, you must select the underlying horizontal scrollbar. 
The additional existing Channel direct access buttons are modified under "Application settings". There 
the assigned DMX channel numbers are set, which are then accessed at once by pressing these buttons. 
 
Per step, different DMX values for each channel can be set. By stringing together several steps with 
various DMX values a dynamic light image can be created. The "step list" includes all steps in 
chronological order. The transition between two steps determines the cross-fade (Fade time) and hold 
time (Wait time), which can be set separately for each step. The option "Change all steps" is for to 
change the "Fade Time" and "Wait Time" to all landscaped steps in the Step list. 
 
Get DMX IN 
Not in function for the DMX Gateway. 
 
Rotate channels left / right  
Causes the set all DMX values are shifted by one channel to the right (+1) or left (-1). This allows the 
easy creation of "chaser" scenes. 
 
  

Step-Liste 

Channel Control 

Channel – direct access button Shift to left Shift to right 

Faid and Hold 

Reapeat Scenes 

DMX-Value 
Input 

DMX-Group Control 

DMX-Master Control 
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5.2.6 COLOR PICKER 

The color picker makes entering RGB color values easy. In this case be 3 
consecutive DMX channels, the R / G / B values of a selected color is 
assigned. To achieve the color picker, click on the first RGB (of 3) DMX 
channels with the right mouse. 
 

This opens a menu with the  then the left mouse button must be 
clicked. 
 
The dialogue of the Color Picker is available in 2 different views. Left the 
standard representation (normal style) and the on the right color distribution as color wheel (round 
style) is shown, 
 
Go for color selection as follows: 

 Select the color from the color representation 
 Select the color brightness 
 Click on OK and the settings for R / G / B can be taken 

 
 
 

                      
Figure 18: Color Picker – different views 

 
 
 
Note: By clicking the right mouse button on the controller for color brightness make this center 
to 50%. 
  

Figure 17: Color Picker 
selection 

brightness 

Color shape 
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5.2.7 DMX-GROUPS 

DMX groups are suitable for simultaneous editing of multiple channels. There are 16 groups available 
where you can combine any channels. 
 
To create or edit the group, select in the menu "Settings"> "Application settings" and then choose the 
Tab "Groups”. 
 

 
Figure 19: define DMX groups 

 
In the box next to the group name the DMX channels must be entered, which form the group. Here, the 
separation of DMX channels is made with a semicolon. One DMX-channel can belong to different 
groups. 
 
After you define the groups you will see them in the group selection. By selecting a group, the selected 
channels are marked in the box and activated. They are tied together and all channels are set to the 
same value as soon as one of the fader is changed. 
If you need additional channels that are not defined as a group, you can add them by manually 
selecting the check box temporarily. 
 

 
 
 
 
 
 
  

Displaying the connected channels 
group selection 
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5.2.8 DMX-MASTER GROUP 

A special group is the master group. The listed DMX channels can be scaled to the output on the 
connected interface according to the master value. 
 
Example 1:  DMX value = 100%;  Master = 50%  50% results in the output channel 
 
Example 2:  DMX value = 50%;  Master = 50%  25% results in the output channel 

 

  
 
 
 

5.2.9 COUPLING OF SCENES  

What action is executed after the last step in a scene is set by the selection box under the step list. 
 

• Repeat after last step: The scene is running in an endless loop. 
• Stop after last step: The scene will stop the execution after the last step. The light image 

of the last step remains unchanged. 
• Execute: The selected scene is performed after the last step. 

 
 

5.2.10 SAVE AND LOAD PROJECTS 

Under the File menu, you can store your steps and created scenes as a project and 
open it again. The created files are in the specific format *.dx1. 
 
 
 
  

DMX-Master 

activate BlackOut  

Figure 20: DMX 
Master Control 

Figure 21: Load 
and save projects  
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Figure 24: start RGB Editor 

5.2.11 EXPORT AND IMPORT SCENES 

In addition, you can save individual scenes separately. This is useful if you need 
the same scene in another project. To save individual scenes using the menu 
Scene -> Export. The saved file has the extension "* scn.".  With the menu Scene -
> Import an exported scene in your project is added. 

 
 

5.2.12 EXPORT AND IMPORT OF STEPS 

The separate storage of Steps is analogous to these of the scenes. To save 
individual steps using the menu Step > Export. The saved file has the extension "*. 
stp". The menu item Step> Import you can add a step to the end of the step list. 
 

 
 

5.2.13 RGB EDITOR 

The RGB Editor is specifically designed for the production of light images 
with LED stripes or LED panels. Enable the DMX-editor in the menu under 
Settings> RGB Editor. The sliders are replaced by colored rectangles. 
These represent the individual RGB channels. 
 
 
 
 
 
5.2.13.1 CONFIGURE RGB EDITOR  

You can configure the display and the assignment of the 
RGB settings to the DMX channels. To do this, select the 
menu item Settings> Application settings and then go to 
the Tab RGB Editor. 
 
This opens a dialog where you will find the following 
settings: 

 Pixel H: Indicates how many RGB fields should be 
arranged horizontally. 

 Pixel V: Indicates how many RGB fields should be 
arranged vertically. 

 First Pixel offset: Specifies how many DMX 
channels are before the first pixel 

 Channels/Pixel: Specifies how many DMX 
channels can be assigned to a pixel. Follow all RGB 
channels directly on one another, is here to provide third More control channels or a channel W 
are used, must be stated here also that much more. 

 Example: The DMX4all LED dimmer is indicated here since five channels for a total of 5 RGBW 
and STROBE are used. 

 Channel R: Specifies which (first) channel is assigned to used RED 
 Channel G: Indicates which channel is assigned to the used GREEN 
 Channel B: Indicates which channels is assigned to used BLUE 

 
ATTENTION:  
RGB fields to a maximum of 512 channels can be predefined. 
  

Figure 23: Export and 
Import of Steps 

Figure 25: RGB Editor Configuration 

Figure 22: Scene 
Export and Import 
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5.2.13.2 USE OF RGB EDITOR  

Also be using the RGB Editors has generating scenes and steps as before. Have you created a step, the 
current information will be displayed on the RGB color fields. 
 

 
Figure 26: Color Picker 

 
You can edit the individual fields by clicking the right mouse button on the RGB box. It now opens a 
menu from which you select “Color Picker”. This will open the Color Picker window as already known. 
 
In order to copy colors from one field to another, simply click the right mouse button on the RGB box 
and select “copy”. Now you can click on “paste” or -by using the left mouse button in an RGB color box 
– “copy” it direct in place. 
 
NOTE: After you select a new color with the Color Picker, this color is automatically used by 
“copy”. This is indicated by the colored arrows at the cursor. 
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5.2.14 CHANNEL SOFTPATCH 

To edit the soft patch settings, select the menu item “Settings> Channel SoftPatch”. 
 
The column “output channel“ allows a subsequent matching of existing scenes to a other existing 
installation. Thus, the scenes remain unchanged and only the assignment of the individual channels 
must be new. No double seizure 
 
In order to terminate the input with no changes, press Cancel. Press “OK”, changes into the current 
project are accepted. Reset restores the default settings. 
 
NOTE: In one project (dx1-File) only one separate channel setting is possible! 
 
 

 
Figure 27: Channel Soft Patch 
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5.2.15 DEVICE MANAGER 

In order to assemble the individual DMX channels into devices, it is necessary to define in the device 
management which channels belong to a device. The device management is accessed via the menu 
option Settings → Device management.  
 

 
Figure 28: Device Manager 

 
In the left-hand side of the window all DMX channels are listed (addresses 1 - 512). If a channel is 
marked, it can be assigned a name and specific colour using the input mask on the right. In order to 
define RGB and RGBW devices, proceed as follows: 
 
RGB device: 

 Mark the first channel of the required DMX device (e.g. channel 1 “Ch1”). 
 Under “Name” in the right-hand configuration window, enter the required name of your DMX 

device (e.g. “RGB lights 1”). 
 Now right-click on the channel and select “Add RGB channels”. The device management 

automatically adds the RGB channels.  
An RGB device is now defined. It is given the name that you assigned in the first channel.  
 
RGBW device: 

 Same as above, except that “Add RGBW channels” must be selected.  
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5.2.16 APPLICATION SETTINGS 

Under the menu “Settings”> “Application settings” 
changes for the main program are possible. 
 
The settings are divided into several groups. 
 
“Load Program” specifies file on startup, which is 
loaded when starting the software. 

 “None”: There is no project loaded 
 “Load specified file”: it will load the specified 

project. With  the project file is selected. 
 “Load, last opened file”: The last opened 

project is loaded 
 
 
 

5.2.17 STORAGE LEVEL INDICATOR 

Since DMX Configurator Version 1.6.0.0, there is a storage level indicator. The DUODMX GATEWAY has 
a total space of 64 Kbytes. The level indicator shows you how much of this memory is used in your 
current configuration. Transfer more information to a device, there will be malfunction. 
 

  
 
 
Note: Even after shipment, a part of the memory is already occupied by the communication 
objects.  
 
  

Figure 29: Application Settings - File 

Figure 30: storage level indicator 
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5.3 MENU „EXTENSIONS“ 

The specific settings for the DUODMX GATEWAY are made in the menu "Extensions". Here the linking 
with the group addresses or EnOcean profiles, IP address assignment, and the transmission of 
configuration data is made. In addition, devices can be detected in the network there, the DMX Preview 
can be activated and switching between master and slave mode can be performed.  
 

5.3.1 DEVICE VARIANTS  

Before the specific settings of the DUODMX GATEWAY can be carried out, the device versions must be 
selected. When you call the “Expansions” menu for the first time, the following selection appears: 
 

  
Figure 31: Device Variants 

 
Select the respective “bus type” according to the version of your device. Overview of bus types/device 
versions: 
(You can find out which version your device is from the marking on the front.) 
 
KNX/BMX 

 12000 DUODMX GATEWAY Extension for EIBPORT 
 12010 DUODMX GATEWAY KNXnet/IP 
 12020 DUODMX GATEWAY KNX/TP 
 

KNX/BMX Master/Slave 
 12100 DUODMX GATEWAY Extension SR 
 12110 DUODMX GATEWAY KNXnet/IP SR 
 12120 DUODMX GATEWAY KNX/TP SR 

 
EnOcean 

 12030 DUODMX GATEWAY EnOcean 
 
WLAN 

 12040 DUODMX GATEWAY Standalone 
 
If the selection is made the configuration window for each technology / bustyp is opened. As long as 
the project is not saved, this selection is reopened each time the Extension DUO-DMX Gateway is called. 
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5.3.2 KNX/BMX CONFIGURATION 

If, in the case of the DUODMX GATEWAY, it concerns a KNX or extension device, the bus type 
“KNX/BMX” must be selected in the device selection.  
 

  
Figure 32: device selection - KNX/BMX 

 
This applies to the following device types: 

 12000 DUODMX GATEWAY Extension 
Control via the BMX protocol (network-based) of the EIBPORT. See also the section on 
“Extension device version“ 

 12010 DUODMX GATEWAY KNXnet/IP 
Control via the KNXnet/IP protocol (network-based). 

 12020 DUODMX GATEWAY KNX/TP 
Control via KNX twisted pair (twisted pair bus).  

 
In every case, the control is by means of KNX group addresses; only the transmission path of the 
telegrams differs.  
 
After selecting this bus type, the “Expansion” window opens with KNX-specific parameters. The window 
is divided into two parts: The group address management takes place in the left half of the window, 
while the links with DMX and the “LAN/KNX“ configuration are in the right half.  
 

 
Figure 33: Configuration "KNX/BMX" 
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5.3.2.1 LINKING OF KNX GROUP ADDRESSES 

The DMX channels of the two outputs and the created scenes must be 
linked to group addresses if you want to control devices with 
"Extension"(Art.-Nr. 12000), "KNXnet / IP"(Art.-Nr. 12010), "KNX / TP" 
(Art.-Nr. 12020) and „Extension SR“ (Art.-Nr. 12100), „KNXnet/IP SR“ 
(Art.-Nr. 12110), „KNX/TP SR“ (Art.-Nr. 12120). First of all, addresses 
must be available in the group address management for this purpose. 
There are two possible ways of achieving this: 1. Set up group addresses 
in the DMX configurator, or 2. use ESF data import. 
 
 
 
 
 
 
 
 
 

Figure 34: Group address management 
 
SET GROUP ADDRESSES WITHIN THE DMX-CONFIGURATOR  

If no appropriate ESF file with the corresponding group address exists, the group addresses can be 
created directly in the DMX-Configurator. Proceed as follows: 
 

1. Create a Main-, Middlegroup: 
Click the right mouse button into the empty group address field while "group addresses" is 
checked. You will be prompted to create a new main group and can assign a name. Then click 
on the main group with the right mouse button and create a new Middle group.  
 

2. Setting up a group address 
The required group address is set up by right-clicking on the middle group. A window then 
appears, in which “Number“, “Name“ and “Object type“ can be specified.  
 

 
Figure 35: set group addresses 
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Object types: 
 1 bit: DPT 1.001 (switch EIS 1), value: [0.1] 
 4 bit: DPT 3.007 (dim EIS 2 relatively), value: [brighter, darker, stop] 
 1 byte: DPT 5.001 (EIS 6 percent), value [0 – 100%, step size 0.4%] 
 3-byte DPT 232.600 RGB, value [R 0 - 255, G 0 - 255, B 0 - 255] 
 4-byte DPT 12.001 4-byte unsigned as RGBW, value [(0…4 294 967 295): 1. Byte = R, 2. 

Byte = G, 3. Byte = B, 4. Byte = W] 
 

3. Deleting entries:: 
To delete an entry, highlight it and press the Delete key („Entf“/ „Del“) on your keyboard. 

 
 
USING ESF DATA IMPORT 

In order to link the group addresses of an ESF file (group address file ending with *.esf), it must first be 
exported directly from the ETS (or from the EIBPORT). For all objects of the DUODMX GATEWAY the 
following data types are relevant: 

 1 bit: DPT 1.001 (switch EIS 1), value: [0.1] 
 4 bit: DPT 3.007 (dim EIS 2 relatively), value: [brighter, darker, stop] 
 1 byte: DPT 5.001 (EIS 6 percent), value [0 – 100%, step size 0.4%] 
 3-byte DPT 232.600 RGB, value [R 0 - 255, G 0 - 255, B 0 - 255] 
 4-byte DPT 12.001 4-byte unsigned as RGBW, value [(0…4 294 967 295): 1. Byte = R, 2. 

Byte = G, 3. Byte = B, 4. Byte = W] 
 
In order to import an ESF file into the DMX configurator, proceed as follows: 
 

1. Import an ESF(groupadress-) file   
Open in the DMX-Configurator menu "Extensions"> "KNX"> "Import ESF" 

 
 

 
Figure 36: import ESF file 

 
 

After selecting the desired ESF-file, in the left window of the address tree is displayed. The tree 
can be expanded or collapsed by clicking on the small “+” and “-” buttons.   
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5.3.2.2 GROUP ADDRESS LINKING 

above), they can be used for being linked with various KNX objects of the DMX interfaces. The scene link 
“Scene Out“, the link with dimmer channels “Dimmer Out“ and scene links with predefined devices 
“Device“ are available. 
 
 
LINKING THE SCENES: („SCENE OUT“) 

In the Tab “Out Scene 1 "and" Scene out 2 "all previously scaled scenes are listed. The scenes can be 
linked with the following data type  
 

 1 bit: DPT 1.001 (switch EIS 1), value: [0.1] 
  

Scenes are started by telegrams with the value “1“ and either stopped or paused with the telegram 
value “0“ (see Section “LAN/KNX“).  
 
To create a link, proceed as follows: 

 Simply drag the required group address from the address tree on the left onto the 
corresponding scene on the right. The group address will then be displayed below the scene. 
(see diagram below) 

 
Note: During the linking procedure, the program automatically checks whether the selected 
group address has the correct data type for the communication object. If it does not, this link is 
not possible and the group address cannot be linked.  
 

 
Figure 37: linking group addresses to scenes 

 
Each scene can be launched from any number of group addresses. Simply all relevant addresses are 
dragged to the scene. 
 
LINKING DMX CHANNELS 

In addition to the scenes, the DMX channels can be individually controlled. Each of the 512 DMX 
channels maps its own KNX dimmer channel with the objects “1-bit switching“, “4-bit dimming“ and 
“1-byte absolute dimming“.  
 
Note: The 1 byte value functions not only as an input, but also as an output. This means that if the 
channel is changed by one of the two other objects, the corresponding  brightness value – if 
appropriately linked – is transmitted to KNX.  
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 1 bit: DPT 1.001 (switch EIS 1), value: [0.1] 
 4 bit: DPT 3.007 (dim EIS 2 relatively), value: [brighter, darker, stop] 
 1 byte: DPT 5.001 (EIS 6 percent), value [0 – 100%, step size 0.4%] 

 
The 1-byte group address object can be linked with several group addresses. In this case, the respective 
1st group address is transmitting and receiving, whereas all other addresses are only receiving. If the 
object is switched by means of 1 bit, the communication object assumes the last value to be set. If, for 
example, the object has been dimmed to 50% by means of a dimming command, and then switched 
off, it is adjusted to 50% when it is switched on again.  
 
To create a link, proceed as follows: 
 

 Simply drag the required group address from the address tree on the left onto the 
corresponding device on the right. The group address will then be displayed below the scene. 
(see also diagram below) 

 
Note: During the linking procedure, the program automatically checks whether the selected 
group address has the correct data type for the communication object. If it does not, this link is 
not possible and the group address cannot be linked.  
 

  
Figure 38: Linking the dimmer channels 

 
LINKING WITH PREDEFINED DEVICES (“DEVICE”) 

Apart from the dimmer channels and the scenes, group addresses can also be linked with DMX devices 
previously defined in the DMX configurator. One of these DMX devices can consist of either 3 (RGB) or 4 
(RGBW) DMX channels. In order to be able to control these devices directly with a group address, the 
following data types are to be used:  
 

 3-byte DPT 232.600 RGB, value [R 0 - 255, G 0 - 255, B 0 - 255] 
 4-byte DPT 12.001 4-byte unsigned as RGBW, value [(0…4 294 967 295): 1. Byte = R, 2. 

Byte = G, 3. Byte = B, 4. Byte = W] 
 
In order to assemble the individual DMX channels into devices, please proceed as described in the 
section “Device management“. If the devices have been defined there, they appear automatically in the 
“Device 1” and “Device 2” windows. To create a link, proceed as follows: 
 

 Simply drag the required group address from the address tree on the left onto the 
corresponding device on the right. The group address will then be displayed below the scene. 
(see also diagram below)  
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Note: During the linking procedure, the program automatically checks whether the selected 
group address has the correct data type for the communication object. If it does not, this link is 
not possible and the group address cannot be linked.  
 

  
Figure 39: Link with predefined devices 

 
 
5.3.2.3 LAN/KNX 

The network and KNX-specific settings are performed on the “LAN/KNX“ tab.  
 

 
Figure 40: Extension DUODMX GATEWAY “KNX" 

 
1. Activate/deactivate DHCP.  

 
2. IP address setting and KNXnet/IP (routing) multicast group.  
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3. List of the DUODMX GATEWAYs located in the network. This is updated by clicking on the 
“Search” button. The respective gateway is displayed with its IP address, the assigned name and 
current firmware version number (since firmware version 2.0.0.1). If no name has yet been 
assigned to the device, its MAC address is displayed. With a mouse click, a device can be marked 
for uploading of configuration data or activation of the Unicast preview.  
 

4. By using the “Search“ function, all DUODMX GATEWAYs present in the network are displayed. If 
the required device is marked in the list and the “Upload“ button is clicked, all current 
configuration data is transmitted to the device via the network (PC and DUODMX GATEWAY 
must be located in the same network).  
 

5. At this point, it is decided for which of the two DMX interfaces the Preview is to be activated. 
The Preview is generally not activated until one of the boxes has been checked (“Broadcast 
Preview“). If a device in the “DMX Gateways“ list is additionally marked, the Preview applies only 
to this device (“Unicast Preview“). In this case, the PC and the Gateway must be located in the 
same network area (subnet). (See also the section on “Activating the DMX preview“).   
 

6. Determines how an initiated scene behaves if a telegram with the value “0“ is sent to its linked 
group address. If “Pause” is set, the scene in progress is stopped and will resume again at this 
point when it is triggered again. If “Stop” is set, the scene starts again from the beginning when 
it is triggered again.  
 

7. Assign a physical address for the KNX versions of the device.  
 

8. The EIBPORT System ID is permanently set to the default value “0“. This value must be specified 
when creating the system coupling job (BMX protocol) in the EIBPORT and is only of interest to 
the “Extension“ version of the gateway. (See section “Extension device version“).  
 

9. Here you can assign every device a unique name. This name is displayed in the “DMX Gateways“ 
list instead of the MAC address.  

 
 

5.3.3 „KNX/BMX MASTER/SLAVE“ CONFIGURATION 

If, in the case of the DUODMX GATEWAY, it concerns a KNX or Extension device with integrated 
master/slave function “SR” (send/receive), the bus type “KNX/BMX” must be selected in the device 
selection.  
 

 
Figure 41: device selection "KNX/BMX Master/Slave 

 
This applies to the following device types: 
 

 12100 DUODMX GATEWAY Extension SR 
Communication (sending/receiving) via the BMX protocol (network-based) of the EIBPORT. See 
section on “Extension device version“. 
 

 12110 DUODMX GATEWAY KNXnet/IP SR 
Communication (sending/receiving) via the KNXnet/IP protocol (network-based). 
 

 12120 DUODMX GATEWAY KNX/TP SR 
Communication (sending/receiving) via KNX Twisted Pair (wire pair bus).  
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In every case, the communication is performed by means of KNX group addresses; only the transmission 
path of the telegrams differs. The configuration window for these device types differs only slightly from 
that of the KNX/BMX configuration. 
 
5.3.3.1 SPECIAL FEATURES OF MASTER / SLAVE FUNCTION 

In the device versions ending with “SR” there is the possibility of operating one or both DMX interfaces 
not only as a DMX Master (sending) but also as a DMX Slave (receiving). For this reason there are 
checkboxes on the “LAN/KNX” tab (only after selecting the correct device version, see above) for 
setting the operating mode of the DMX interfaces separately from one another.   
 

  
Figure 42: Configuration for DMX-Slave 

 
By checking a box, the corresponding DMX interface is switched to slave mode. 
 
MASTER / SLAVE CONNECTION 

In order to be able to transmit and receive simultaneously on one DMX cable, a jumper can be inserted 
from one interface to the other. The DMX interfaces are short-circuit proof. For example, if “DMX-Out 1” 
is defined as the Master and “DMX-Out 2” as Slave, both DMX interfaces are directly connected to one 
another at the terminal.  
 

 
Figure 43: Wiring diagram Master / Slave on a device 
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BEHAVIOUR OF THE COMMUNICATION OBJECTS FOR STATUS FEEDBACK 

In order to receive the DMX channel values as KNX telegrams in slave mode, the corresponding channel 
of the DMX interface in slave mode must be allocated a corresponding group address. Only the 
following communication objects of the dimmer channels (“Dimmer Out 1” and “Dimmer Out 2”) are 
relevant for this: 
 

 1 bit: DPT 1.001 (switch EIS 1), value: [0.1] 
 1 byte: DPT 5.001 (EIS 6 percent), value [0 – 100%, step size 0.4%] 

 
If therefore, as in the example above, the DMX interface 2 is configured as a slave, both communication 
objects of the corresponding DMX channel in “Dimmer Out 2” can be linked with the addresses for the 
status feedback.  
 

  
Figure 44: Link to an address for status feedback 

 
Note: If you configure one DMX interface as a DMX master and one as a DMX slave, please note 
that not transmission takes place not only on the 1 byte group address of the configured DMX 
slave interface (the actual value incoming from DMX), but also on the 1 byte communication 
object of the sending channel (the current value of the communication object).  
 
5.3.3.2 GROUP ADDRESS MANAGEMENT 

See section “Configuration for “KNX/BMX”“. 
 
Setting up group addresses in the DMX configurator 

See Section “Configuration for “KNX/BMX”“. 
 
Using ESF data import 
See Section “Configuration for “KNX/BMX”“. 
 
5.3.3.3 GROUP ADDRESS LINKING 

See Section “Configuration for “KNX/BMX”“. 
 
Linking of the scenes (“Scene out”) 
See Section “Configuration for “KNX/BMX”“. 
 
  



 Programming DUO DMX Gateway 

 

38 b.a.b-technologie gmbh DUO DMX Gateway  

 

Linking of the DMX channels (“Dimmer out”) 
See Section “Configuration for “KNX/BMX”“. 
 
Linking with predefined devices (“Device”) 
See Section “Configuration for “KNX/BMX”“. 
 
 
5.3.3.4 LAN/KNX 

See Section “Configuration for “KNX/BMX”“. The configuration differs here only in terms of the 
additional parameters for DMX master / slave (see above) 
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5.3.4 „ENOCEAN“ CONFIGURATION 

If, in the case of a DUODMX GATEWAY to be configured, it concerns a device with built-in EnOcean 
transceiver, the option “EnOcean” must be selected in the device selection. The selection applies to the 
following device types: 
 

 12030 DUODMX GATEWAY EnOcean 
Control is by means of EnOcean radio profiles.  

 

 
Figure 45: device selection "EnOcean" 

 
 
5.3.4.1 LINKING OF ENOCEAN PROFILES 

In the left half in the "transmitter" will be displayed all from the gateway received EnOcean profiles be 
listed. The profiles will be displayed with their EnOcean specific names. With two clicks (note: Not 
double-click) on the profile name will be a renaming possible. Give the profile a name such as 
"Switch_Wippe1_ON" to assign it better later on. 
 

  
Figure 46: EnOcean Configuration – naming of profiles 

 
The DUODMX GATEWAY in the EnOcean variant, supporting the profiles” ORG0x5 ". These profiles 
correspond e.g. Touch sensors or window handles. To delete a received profile delete from the list, it 
must be marked and removed with the "Del" key. If the profiles are named in this way and light scenes 
are set up with the aid of the DMX configurator (see Section “Creating scenes“), the profiles are simply 
dragged and dropped onto the required channels or scenes.  
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Figure 47: EnOcean – Linking of scene 

 
LINKING THE SCENES 

In case of EnOcean the scenes will be launched and stopped with the same profile. That means one 
rocker switch can start and stop (or pause) two different scenes. The behavior of the scenes in a "stop" 
message is in the tab "LAN/EnOcean" can be determined. 
 
More than one profile can be linked to a scene. To delete a link, it is enough to mark it and then press 
the "Del" key. 
 
LINKING DMX CHANNELS 

To link the DMX dimming channels in the DMX outputs directly with EnOcean profiles both profiles of a 
rocker switch must be linked to each channel. 
 

  
Figure 48: EnOcean – linking of DMX channels 

 
The DUODMX GATEWAY detects a dim-signal when a rocker switch is pressed for longer than 500ms, 
and ended it as soon as the button is released. The dimming up is done by holding the "ON" switch of 
the rocker, the dimming down by holding the "OFF" switch. 
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5.3.4.2 LAN/ENOCEAN 

For the description regarding network settings, search function, behaviour of scenes and device name, 
please refer to Section “LAN/KNX“ (see above). 
 
SPECIAL FEATURE OF LAN/ENOCEAN CONFIGURATION 

A peculiarity of the DUODMX GATEWAY EnOcean variant is that in addition to its gateway functionality 
it also provides a repeater function. The device repeats all EnOcean signals that it receives again and 
therefore amplifies the range of the signal. There are two choices 
 

  
Figure 49: EnOcean Extension - Repeater Functionality 

 
1. Check boxes to activate the repeater EnOcean function. 

 
EnOcean repeaters 
The unit will repeat all received EnOcean radio signals with a lower transmission power. In a system with 
several repeaters thus prevent that a signal is repeated twice. 
 
Level 2 Repeater 
The unit will repeat the signals at full transmission power. Should only be used, if it is ensured that the 
repeated signal does not reach a second repeater. 
 
  

1 
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5.3.5 „WLAN“ CONFIGURATION  

If, in the case of a DUODMX GATEWAY to be configured, it concerns a device with built-in wireless LAN 
module, the option “WLAN” must be selected in the device selection. The selection applies to the 
following device types: 
 

 12040 DUODMX GATEWAY Standalone 
Control is via the wireless network using an iOS or android app.  

 

 
Figure 50 device selection - WLAN 

 
Device versions are not yet available! 
 
 

5.3.6 CHANGING THE IP ADDRESS CONFIGURATION 

In order to change the IP address settings of a device that has already been put into service (without 
changing the subnet mask), proceed as follows: 
 
Note: If the IP address configuration is to be fundamentally changed, the configuration change 
must be performed using an SD card. See Section “Initial commissioning“. 
 

 When selecting “KNX/BMX“ and “KNX/BMX master/slave“ on the “Lan/KNX“ tab, switch to the 
“Lan/EnOcean“ tab when selecting “EnOcean“ and to the “WLAN“ tab when selecting 
“WLAN“. The diagram below shows a sample configuration for “KNX/BMX“.  

 
 Below the “DMX Gateways“ field, click on the “Search“ button. This displays all DUODMX 

GATEWAYs to be found in the network, regardless of the IP addresses of the local PCs.  
 

  
Figure 51: DMX-Configurator - Window Lan/KNX 

 
Note: If the device still does not appear in the list after you have clicked on the “Search” button, 
there is probably a problem with your network configuration (e.g. firewall / router settings), or 
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you have activated two network cards simultaneously. Please carry out the necessary checks. If 
you are in any doubt, please contact BAB Technology Support. 
 

 Check the IP address of the gateway that is set in the “DMX Gateways” window.  
 

 In order to provide the DUODMX GATEWAY with a new configuration, you must adapt the 
address area of your PC where necessary, so that it matches the address area of the DUODMX 
GATEWAY.  

 
Note: Configuration data can only be transferred if the DUO DMX GATEWAY and PC are located in 
the same network area (subnet)! 
 

 Open the network settings of your computer (Example: Windows 7), and give your computer an 
IP address in the subnet of the DUODMX GATEWAY.  

 

  
Figure 52: Windows - Network Settings 

 
 Switch to the “Lan/KNX“, “Lan/EnOcean“ or “WLAN“ tab and change the IP address settings 

according to your requirements.  
 

 
Figure 53: DMX-Configurator - IP-Adressen Settings 

 
 When requested, assign a name to the device. 

 
 Switch back to the window of the DMX configurator and mark the required device in the “DMX 

Gateways“ list. When you click on “Upload“, the current settings are transferred from the DMX 
Configurator to the DUODMX GATEWAY. A successful transmission is confirmed with the 
message “Upload done“. Otherwise, you receive an error message. Check the network settings 
of PC and DUODMX GATEWAY one more time.  
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Figure 54: DMX-Configurator – configuration transfer 

 
 Then exit the “Lan/KNX“, “Lan/EnOcean“ or “WLAN“ window by clicking “OK“ and save the 

current settings via the menu option “File“ – “Save as“ as project file “*.dx1“. Please use this 
project file for the subsequent project setup.  

 

  
Figure 55: DMX-Configurator – save project 

 
Note: If you would like to use a new or different project, please note the IP address settings. The 
factory settings for the IP address will appear again in every new project. In the case of a new 
“Upload” without changing the settings, the device would receive the new IP address settings.  
 
 

5.3.7 TRANSFER OF CONFIGURATION DATA 

The configuration data can be transmitted over the network or via an SD card. The configuration data 
contains:  

 All DMX-relevant data (scenes, channels, devices) 
 All links 
 IP addresses and configuration data 

The one exception are the settings for the “DMX Preview”. 
 
 
5.3.7.1 TRANSFER VIA NETWORK 

To transfer the data over the network to the device may have to face the PC and DUODMX GATEWAY in 
the same area network (subnet). If necessary, change the network settings of your PC before. See 
capture “CHANGING THE IP ADDRESS CONFIGURATION”) 
 
To transfer configuration data via the network, proceed as follows: 

 When selecting “KNX/BMX“ and “KNX/BMX master/slave“ on the “Lan/KNX“ tab, switch to the 
“Lan/EnOcean“ tab when selecting “EnOcean“ and to the “WLAN“ tab when selecting 
“WLAN“. The diagram below shows a sample configuration for “KNX/BMX“.  

 Below the “DMX Gateways“ field, click on the “Search“ button. This displays all DUODMX 
GATEWAYs to be found in the network, regardless of the IP addresses of the local PCs.  
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Figure 56: DMX-Configurator - Windows LAN/KNX 

 
Note: If the device still does not appear in the list after you have clicked on the “Search” button, 
there is probably a problem with your network configuration (e.g. firewall / router settings), or 
you have activated two network cards simultaneously. Please carry out the necessary checks. If 
you are in any doubt, please contact BAB Technology Support. 
 

 Now mark the required device in the “DMX Gateways“ list. When you click on “Upload“, the 
current settings are transferred from the DMX Configurator to the DUODMX GATEWAY. A 
successful transmission is confirmed with the message “Upload done“. Otherwise, you receive 
an error message. Check the network settings of PC and DUODMX GATEWAY one more time.  

 

 
Figure 57: DMX-Configurator - configuration transfer 

 
Note: Due to the "Upload" will not save the configuration data. If you close the DMX-
Configurator, all changes made are lost. 
 
 
5.3.7.2 TRANSFER VIA SD-CARD 

In addition to storing as DMX project file each project can also be exported as a so called "HEX file" too. 
This file format is required to transmit the configuration data to the DUODMX GATEWAY. This 
configuration file must always have the same name ("config.par") so that the DUODMX GATEWAY reads 
and recognizes them as such. The green "Power" LED sheds light on the state of charge (as long as the 
LED is off , the file is being read). A configuration file is created as follows (after the project is saved as  
*.dx1 file.) 
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• Open the menu "File"> "Export Hex File" 
• Save the HEX file with a unique name in the appropriate folder 
• Create a folder on your hard drive for the "config.par" file 
• Then copy the generated HEX file into the folder and rename it in to "config.par" 
• Insert the SD card into the card reader and move  the new "config.par" on the SD card 
• Insert the SD card into the slot of the DUODMX GATEWAY and wait until the green LED lights up 

again. Ready. 
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6 FIRMWARE UPDATE 

To update the firmware of the DUODMX GATEWAY, please proceed as follows: 
 

• Use a blank SD card and copy the latest firmware file on it. The firmware file must be named 
"dmxknx.fir". 

• Unplug the DUODMX GATEWAY from the power supply and insert the SD card into the SD 
card slot. 

• Press the "button" and hold it down while you connect the power supply again. 
• Wait until the LED of the DUODMX GATEWAY has stopped to flicker and then release the 

button. 
• Remove the SD card and start the machine again by separation of the supply voltage. 
• After a successful reboot is the device works with the latest firmware. 
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7 DEVICE TYPE „EXTENSION“ (EIBPORT 
EXTENSION) 

If the DUODMX GATEWAY is used as an extension for EIBPORT, both devices are “talking” about 
EIBPORT own BMX protocol. For this is the job of EIBPORT "linking facilities" is used. In the following the 
necessary steps will be described. 
 
 

7.1 CHECK/SET COMMUNICATION PARAMETERS  

The BMX protocol used for communication either TCP or UDP. In this case, the communication over UDP 
(User Datagram Protocol) is used. Thus the sender (EIBPORT) and receiver (DUODMX GATEWAY) can , 
“talk” together, they must communicate over the same port number. 
 
BMX Port 
Cause in the DUODMX GATEWAY the port number cannot be changed it must be set correctly in the 
EIBPORT. About the "System" - "Configuration" - "Advanced EIB (yabus) Settings" check the port 
number in EIBPORT. 
 

  
Figure 58: EIBPORT Communication Parameter 

 
The correct port number is "1735". This number is the default of EIBPORT, but because this number 
can be changed it should be checked before. 
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System ID 
In addition, for the facilities coupling a so-called "System ID" is used. That's a number from 0-255 and is 
used -in the case of the facility coupling - to differ coupled KNX facilities from each other in virtual 
plants. For the DUODMX GATEWAY the EIBPORT has to have the system ID "0". The system ID is set 
under "System" - "Advanced EIB (yabus) Settings" - "Configuration". 
 
Network settings 
EIBPORT and DUODMX GATEWAY must not be in the same network area for communication. The 
control can (with appropriate firewall - configuration) also take place over the internet. 
 
 

7.2 EIBPORT JOB „LINKING FACILITIES“ 

If the messages should be transferred over the BMX protocol to the DUODMX GATEWAY the "linking 
facilities" job is used. This job is also described in the documentation of EIBPORT. Important 
communication parameters are 
 

  
Figure 59: EIBPORT Job – Linking Facilities 

 
Host name / IP address 
Enter the IP address of the DUODMX GATEWAY. If the communication is done via the internet here a 
DynDNS address entered. 
 
connection Type 
It is used for the direct connection via LAN ("direct (LAN)") 
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Target system ID 
Determines to which system ID the packet should be sent. Because the DUODMX GATEWAY ID "0" is set 
by default, must be "0" set here. 
 
Regulate 
You can decide with the help of rules which addresses are transmitted. All addresses, only a single 
address or only selected areas are used. 

Rule Meaning 

*/*    ->   */* All main and sub groups of the EIB-Installation 1 will be coupled 1:1 to EIB-
Installation 2. 

6/*   ->   6/* All group addresses from main group 6 of EIB-installation 1 will be coupled 1:1 
with main group 6 of the EIB-installation 2  

7/*   ->  17/* All group addresses of main group 7 of the EIB-installation 1 will be coupled 
with the virtual main group 17 of the EIB-installation 2  

 In this case no eib address overlapping is possible within installation 2 

*/1  ->   */1 Addresses 0/1; 1/1; 2/1...32/1 are coupled directly with EIB -installation 2  

 
Using these rules it is possible to map group addresses. In case of the DUODMX GATEWAY this makes no 
sense. On the side of the DUODMX GATEWAY only the addresses which have been linked via the ESF file 
are working. 
 
 

7.3 RECEIVING TELEGRAMS IN THE CASE OF 
DEVICE TYPE “EXTENSION SR” 

Telegrams that a DUODMX GATEWAY Extension SR (Art.-No.: 12100) sends to BMX (UDP Port 1735) 
when activating the slave function are received by the EIBPORT without any further action. The 
DUODMX GATEWAY sends the incoming values from DMX by BMX protocol to the network broadcast 
address (XXX.XXX.XXX.255 for subnet 255.255.255.0), so that they can be received by all EIBPORTs 
located in the local subnet. The decisive factors here are the IP address settings of the DUODMX 
GATEWAY. In addition, it should be noted that EIBPORT and DUODMX GATEWAY use the system ID “0”, 
as this is preset in the DUODMX GATEWAY.   
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8 GENERATE ESF DATA 

For linking ESF data with the DMX Configurator you have several options. 
 
ESF data from the EIBPORT device 
Since firmware version 1.0.2 (Version 3) EIBPORT opens up the possibility to export its group address to 
ESF data file. Go to the menu in the "Editor" - "Tools" - "ESF Upload & data maintenance." Insert the 
wanted addresses in EIBPORT and export it as an ESF file. 
 
ESF data from the ETS 
To generate the desired data with ETS, you need the application of a device which controls the data 
types 1bit or 1byte. Linking the addresses you want and export the data as ESF. 
 
ESF file created individually 
Look for an existing ESF file, that contains 1it and 1 byte communication object and open it with a text 
editor. Using the same syntax, you can modify the file so that you comply with your requested addresses 
and data types. 
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